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File Listing

	Task
	Exercise
	Recommended Method
	Student Data File
	Solution File

	Start a New Blank Presentation
	3-1
	Choose File, New. Click Blank Presentation on the New Presentation task pane. 
	None
	None

	Insert New Slides
	3-2
	Click New Slide on the Formatting toolbar. Users can also choose New Slide from the Insert menu or press [Ctrl]+[M]. Alternatively, press [Ctrl]+[Enter] one or more times until a new slide appears. Or, point to a layout thumbnail on the Slide Layout task pane, and then click its down arrow and choose Insert New Slide from the drop-down list.
	None
	None

	Insert a New Slide with a Different Layout
	3-3
	Click New Slide on the Formatting toolbar. Point to a layout thumbnail on the Slide Layout task pane, and then click the desired layout.
	None
	None

	Change the Layout of an Existing Slide
	3-4
	Select a slide. Click the desired layout on the Slide Layout task pane. Alternatively, point to a layout thumbnail on the Slide Layout task pane, and then click its down arrow and choose Apply To Selected Slide from the drop-down list.
	None
	Sol 3-4.ppt

	Apply a Design Template
	3-5
	Click Design on the Formatting toolbar. Click the desired template on the Slide Design task pane.
	None
	None

	Choose a Template Color Scheme
	3-6
	Click Color Schemes in the Slide Design task pane. Click the desired color scheme.
	None
	None

	Change the Color Scheme for Selected Slides
	3-7
	Select the slides by using the [Ctrl]+click method. Click Color Schemes in the Slide Design task pane. Point to a color scheme thumbnail and then click its down arrow and choose Apply to Selected Slides from the drop-down list.
	None
	Sol 3-7.ppt

	Apply a Design Template to Selected Slides
	3-8
	Select the slides by using the [Ctrl]+click method. Point to a design template thumbnail on the Slide Design task pane, and click its down arrow and choose Apply To Selected Slide from the drop-down list.
	None
	Sol 3-8.ppt

	Create a New Presentation from a Template
	3-9
	Choose File, New. Click From design template on the New Presentation task pane. Click the desired template from the Slide Design task pane.
	None
	Sol 3-9.ppt

	Use Cut, Copy, and Paste to Copy and

Rearrange Slides
	3-10
	Click a slide that has to be moved. Click the Cut button on the Standard toolbar. Select the thumbnail of a slide after which the slide that was cut has to be placed. Click the Paste button on the Standard toolbar.
	None
	Sol 3-10.ppt

	Use Copy and Paste to Rearrange Text
	3-11
	Activate a text placeholder and select all its text. Press [Ctrl]+[C]. Activate the text placeholder where the copied contents need to be pasted. Press [Ctrl]+[V].
	None
	None

	Use the Paste Options Button
	3-12
	Select the text that has to be copied. Press [Ctrl]+[C]. 

Display the slide on which the text has to be pasted.

Press [Ctrl]+[V]. Click the Paste Options button and either choose Keep Source Formatting or Use Design Template Formatting from the drop-down list as required.
	None
	Sol 3-12.ppt

	Use the Undo and Redo Commands
	3-13
	To undo or redo a most recent action, click Undo or Redo button on the Standard toolbar. Alternatively, press [Ctrl]+[Z] or [Ctrl]+[Y].
	None
	None

	Insert Slides from Another Presentation
	3-14
	Click the slide thumbnail from where the copied slides should follow. Open the Insert menu and choose Slides from Files. Click Browse in the Slide Finder dialog box, select the file, and then click Open. Retain the Keep source formatting check box unchecked. Click the slides to be inserted, and then click Insert.
	None
	None

	Copy Slides to Another Presentation
	3-15
	Choose Edit, Office Clipboard. Click Clear All at the top of the Clipboard task pane to empty the clipboard. Display the Slides tab, and copy two slides from the current presentation one at a time. Switch to the other open presentation. Click the slide thumbnail from where the copied slides should follow. Click the second slide on the Clipboard task pane. Choose Keep Source Formatting from the drop-down arrow on the Paste Options button.
	None
	Sol 3-15.ppt

	Create Speaker’s Notes
	3-16
	Display a slide where the notes have to be added and click the Notes pane to activate it. Resize the Notes pane. Key the required text.
	None
	Sol 3-16.ppt

	Print Notes Pages
	3-17
	Choose File, Print to open the Print dialog box. Choose Notes Pages from the Print what drop down list box. Choose Grayscale from the Color/grayscale drop down list box and click Preview. Choose the required page orientation in the Print Preview window. Click Print to return to the Print dialog box and click OK.
	None
	None

	Create a new presentation, add new slides, and insert a new slide with a different layout
	3-18
	
	None
	Sol 13-18

	Add new slides, change the slide layout, use the Cut and Paste commands, and insert a slide from another presentation
	3-19
	
	EatGuide.ppt

Balance2.ppt 
	Sol 3-19

	Start a new presentation by using a design template, add new slides, insert new slides with different layouts, change design templates and color schemes, and use the Undo command
	3-20
	
	None
	Sol 3-20

	Change slide layout, change the design template, use the Office Clipboard, and add speaker’s notes
	3-21
	
	Balance2.ppt
	Sol 3-21

	Create a new blank presentation, add slides, change a slide layout, apply a design template, change the color scheme, and cut and paste text
	3-22
	
	None
	Sol 3-22

	Add slides, change slide layouts, change the color scheme, cut and paste text, and insert a slide from another presentation
	3-23
	
	SafeFd1.ppt
SafeFd2.ppt
	Sol 3-23

	Start a new presentation, add slides, apply a template, and change the color scheme
	3-24
	
	None
	Sol 3-24

	Add a new slide, choose a slide layout, insert slides from another presentation, and add speaker’s notes
	3-25
	
	Cookcon1.ppt
Cookcon2.ppt
	Sol 3-25

	
	3-26
	
	None
	None

	
	3-27
	
	None
	None

	
	3-28
	
	None
	None


The outline for this lesson will be presented in the following two sections:



Lecture Outline

· Highlights from the text

· Short discussions on difficult items

Lecture Notes

· Notes

· Teaching tips

· Text figures
· PowerPoint slides
Lesson Outline

Section 3.1

Creating a New Blank Presentation 
This section focuses on:

· Starting a New Blank Presentation

· Inserting New Slides

Section 3.2

Changing Slide Layouts
This section focuses on:

· Inserting a New Slide with a Different Layout 

· Changing the Layout of an Existing Slide

Section 3.3

Working with Design Templates

This section focuses on:

· Applying a Design Template

· Choosing a Template Color Scheme

· Changing the Color Scheme for Selected Slides

· Applying a Design Template to Selected Slides

· Creating a New Presentation from a Template
Section 3.4

Using the Clipboard

This section focuses on:

· Using Cut, Copy, and Paste to Copy and Rearrange Slides

· Using Copy and Paste to Rearrange Text

· Using the Paste Options Button

· Using the Undo and Redo Commands

Section 3.5

Working with Multiple Open Presentations

This section focuses on:
· Inserting Slides from Another Presentation

· Copying Slides to Another Presentation

Section 3.6

Working with Speaker’s Notes

This section focuses on:
· Creating Speaker’s Notes

· Printing Notes Pages

	Lecture Outline
	Lecture Notes

	Section 3.1

Creating a New Blank Presentation 
Users can create a new blank presentation using a design template or a blank presentation. A design template adds a uniform color scheme and design background to each slide in the presentation.

Further, users can build each slide by choosing a slide layout and keying slide text.

Starting a New Blank Presentation

One way to create a presentation is to start with a blank slide, focusing first on content, and then add color and other design elements.
When users start PowerPoint, a blank slide having Title Slide layout appears.
The Outline tab appears on the left side of the screen in Normal view. Both the Slide pane and the Outline pane show the text keyed on a slide.

Inserting New Slides 


Users can insert a new slide in a presentation in one of the following ways:
· Click the New Slide button on the Formatting toolbar.

· Choose New Slide from the Insert menu, or press [Ctrl]+[M].

· Press [Ctrl]+[Enter] one or more times until a new slide appears.

· Point to a layout thumbnail on the Slide Layout task pane, and then click its down arrow and choose Insert New Slide from the drop-down list.
When a new slide first appears on the PowerPoint window, users need not activate a placeholder to start keying text. As the slide pane is active, the text keyed automatically goes into the title text placeholder.


	Lesson Key Objective

Create a PowerPoint presentation and modify layouts and design templates.


[image: image1.emf]Create a New Blank  Presentation

  
[image: image2.emf]Create a New Blank  Presentation


Text Figures: F03-01
Additional Notes:
If PowerPoint is already open and a blank title slide is not displayed, click the New button on the Standard toolbar or choose Blank Presentation in the New Presentation task pane.

Teaching Tip:

Explain the difference between text placeholders and text boxes. Text placeholders are the boxes that appear automatically on a slide where users key title text, subtitle text, and bulleted text. Text boxes are objects that can be added to a slide to insert additional text. They are often used for labels.


[image: image3.emf]Insert New Slides


Text Figures: F03-02, F03-03

Additional Notes:
If the Slide Layout task pane does not appear, open the Format menu and choose Slide Layout. To make sure the Slide Layout task pane appears each time a new slide is inserted, check the Show when inserting new slides box at the bottom of the task pane.
Teaching Tip:

When a new slide is inserted in a presentation, it uses the same layout as the previous slide (unless the previous slide was the title slide).
Teaching Tip:

Students in the habit of pressing Enter at the end of a line might add extra lines in their text boxes. These extra lines can change the size of placeholders and also their placement. So make students aware of this and show them how to delete an extra unused line.



	Section 3.2

Changing Slide Layouts
“Layout” refers to the way things are arranged on a slide. A layout contains placeholders, which in turn hold text such as titles and bulleted lists and slide content such as tables, charts, pictures, shapes, and clip art. Layouts can be categorized as text layouts, which include only text placeholders and content layouts that include placeholders for pictures, tables, and charts.
The Slide Layout task pane enables users to insert a new slide with a particular layout or change the layout of an existing slide or group of slides.
Inserting a New Slide with a Different Layout 
To insert a new slide with a different layout, users need to: 
· Click the New Slide button on the Formatting toolbar.
· Point to a layout thumbnail on the Slide Layout task pane, and then click the desired layout.
Changing the Layout of an Existing Slide

To change the layout of an existing slide, users need to: 
· Select the slide. 

· Click the desired layout on the Slide Layout task pane. Alternatively, they can point to a layout thumbnail on the Slide Layout task pane, and then click its down arrow and choose Apply To Selected Slide from the drop-down list.

	Teaching Tip:

Inform students that after keying text in the left column body text placeholder, they can press [Ctrl]+[Enter] to move to the right column body text placeholder or click in the right column with their arrow pointer.

Text Figure: F03-04


[image: image4.emf]Change the Layout  of an Existing Slide



	Section 3.3

Working with Design Templates

A design template is a file that contains the styles in a presentation, including the type and size of bullets and fonts; placeholder sizes and positions; background design and fill color schemes; and a slide master and optional title master.

A design template can be changed or applied before, during, or after a presentation is created. The template can be applied to all slides or selected slides, and users can apply more than one type of design template in a single presentation. 
Applying a Design Template

Using the Slide Design task pane, users can preview and apply a design template to a presentation. Users can display the Slide Design task pane in one of the following ways:
· Choose Slide Design from the Format menu.

· Click Design on the Formatting toolbar.

· Double-click the current design template name on the status bar.


Choosing a Template Color Scheme

Different preset colors can be applied to the current design template by changing the template’s color scheme. To display preset color schemes for the current design template, users need to click the Color Schemes option in the Slide Design task pane.
Changing the Color Scheme for Selected Slides

To change the color scheme for selected slides:
· Select the slides by using the [Ctrl]+click method.

· Click Color Schemes in the Slide Design task pane.

· Point to a color scheme thumbnail and then click its down arrow and choose Apply to Selected Slides from the drop-down list.
Applying a Design Template to Selected Slides

To apply a design template to selected slides:

· Select consecutive slides by using the [Shift]+click method.

· Point to a design template thumbnail on the Slide Design task pane, and then click its down arrow and choose Apply To Selected Slide from the drop-down list.

Creating a New Presentation from a Template

To create a new presentation from a template:
· Display the New Presentation task pane.

· Click From design template on the New Presentation task pane.

· Click the desired template from the Slide Design task pane.
If a new blank presentation is already displayed on the screen, click Design on the Formatting toolbar to display the Slide Design task pane, and then choose a design template from the thumbnails displayed.
	
[image: image5.emf]Apply a Design  Template
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Text Figure: F03-05

Teaching Tip:

Inform students that changing design templates changes all standard template colors used in the presentation. Clip art colors and other nonstandard colors do not change when a design template changes.

Text Figure: F03-06

Additional Notes:

When referring to color scheme thumbnails, this course assumes that the thumbnails are displayed two across. If your display does not match Figure 3-6, drag the left border of the Slide Design task pane left or right until the thumbnails are displayed two across.
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[image: image8.emf]Apply a Design  Template to Selected Slides


Text Figures: F03-07, F03-08

Teaching Tip:

Inform students that they can apply multiple design templates to a presentation, but they must be careful while doing so. Continuity and uniformity are important to establish a theme for a presentation, and changes should not be applied randomly.

Teaching Tip:

The Apply Design Template dialog box does not necessarily open to the Presentation Designs folder, which contains the designs used in this lesson. Show students how to use the Look In box to navigate to the appropriate folder.



	Section 3.4

Using the Clipboard
Each item that is cut or copied is stored on the Office clipboard. When a selected text or object is cut, it is removed from the presentation and placed on the clipboard. When text or an object is copied, it remains in its original place and a copy is placed on the clipboard. When a clipboard item is pasted, a copy of the item is placed at the insertion point. The copy remains on the clipboard and can be used again if needed.

The Office Clipboard can store 24 items at a time. Clipboard items can be viewed and managed using the Clipboard task pane. When working with the Office Clipboard, it is important to understand that unlike the Cut command, [Delete] does not save items to the clipboard.

The following cut, copy, and paste keyboard shortcuts save a lot of time when doing extensive editing:

· [Ctrl]+[C] to copy

· [Ctrl]+[X] to cut

· [Ctrl]+[V] to insert (paste) the most recent item stored on the clipboard
Pressing [Ctrl]+[C] twice, opens the Clipboard task pane.
Using Cut, Copy, and Paste to Copy and Rearrange Slides
To rearrange slide using the cut and paste commands, users need to:

· Choose Edit, Office Clipboard.

· Click a slide that has to be moved.
· Click the Cut button on the Standard toolbar.
· Select the thumbnail of a slide after which the slide that was cut has to be placed.
· Click the Paste button on the Standard toolbar.
Using Copy and Paste to Rearrange Text

Just as slides are cut, copied, and pasted, the text can also be cut, copied, and pasted and stored on the Office Clipboard.
To rearrange text using the copy and paste commands, users need to:

· Activate a text placeholder and select all its text.
· Press [Ctrl]+[C].
· Activate the text placeholder where the copied contents need to be pasted.
· Press [Ctrl]+[V].
Using the Paste Options Button
The Paste Options button appears near a pasted item if the item’s source formatting is different from the formatting of similar elements in its destination presentation.

A clipboard item’s source is the presentation or other document from which it was cut or copied. Its destination is the presentation or other document in which it is pasted. The Paste Option drop-down list contains the Keep Source Formatting and Use Design Template Formatting options.
Using the Undo and Redo Commands

The Undo button on the Standard toolbar is used to reverse the last editing action executed in a presentation. A series of editing actions can be undone by using Undo more than once. The Redo button reapplies editing commands in the order they were undone. In PowerPoint, unlike Word, the Undo and Redo get disabled when a presentation is saved. In other words, actions performed prior to saving a presentation cannot be undone or redone. 
The keyboard shortcut to undo an editing action is [Ctrl]+[Z] and to redo is [Ctrl]+[Y].
	
[image: image9.emf]Use Copy and Paste  to Rearrange Text


Text Figures: F03-09
Teaching Tip:

Discuss the different icons displayed on the Clipboard task pane. The small PowerPoint icon represents text that was cut or copied from PowerPoint. The PowerPoint icon attached to a slide icon represents a slide that was cut or copied from PowerPoint.

Text Figure: F03-10
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[image: image11.emf]Use the Undo and  the Redo Commands


Teaching Tip:
Inform students that by default, PowerPoint can undo the last 20 actions. This number can be increased or decreased by changing the Maximum number of undos in the Edit tab of the Options dialog box. However, increasing this number uses more RAM on a computer.
Text Figures: F03-11


	Section 3.5

Working with Multiple Open Presentations
Users are often required to adapt a presentation or use part of one presentation and part of another presentation to create a new presentation. To do this, they need to work with more than one open presentation.

Inserting Slides from Another Presentation
Slides can be inserted from other presentations by opening the Insert menu and choosing the Slides from Files command. This action opens the Slide Finder dialog box.

The Slide Finder dialog box enables selecting slides from thumbnails or from a list of slide titles. All the slides in a presentation can be inserted by clicking Insert All.

Copying Slides to Another Presentation
Another way to insert slides from another presentation is to copy and paste the slides by using the Clipboard task pane.
When beginning a new cut, copy, and paste procedure, it is recommended to clear the Clipboard task pane first by clicking Clear All.


	
[image: image12.emf]Insert Slides From  Another Presentation

 
[image: image13.emf]Copy Slides to  Another Presentation


Additional Notes:

The names of the open presentations are displayed on the Windows taskbar at the bottom of the screen. They are also listed in PowerPoint’s Window menu.
Text Figure: F03-12, F03-13
Teaching Tip:

Pressing [Ctrl]+[F6] enables users to cycle through all open presentations.
Teaching Tip:

Inform students that they can store a particular slide in a presentation that is frequently used by clicking the Add to Favorites button in the Slide Finder dialog box. The next time when the slide is required, they need to click the List of Favorites tab to find it quickly.

Teaching Tip:

When inserting all the slides of a presentation, do not select them. Instead, click Insert All.
Additional Notes:

The Paste Options button appears after pasting slides into a presentation one at a time. It does not appear when the Paste All button on the Clipboard task pane is used.

	Section 3.6

Working with Speaker’s Notes
Speakers often use notes to guide their presentations. In PowerPoint, notes pages can be created for slides. A printed notes page (Notes Pages view) contains a small image of the slide and the text that was keyed in the Notes pane. The text can include reminders or facts that are needed for a reference during a presentation. Notes pages can be distributed as handouts, or included with presentations published on the Web.

Creating Speaker’s Notes

Notes can directly be keyed into the Notes pane, which can be made larger, if needed.

Text that is wider than the Notes pane automatically wraps to a new line.

Printing Notes Pages

Notes pages can be printed by choosing the Notes Pages option in the Print what drop-down list in either the Print dialog box or the Print Preview window.


	Additional Notes:

The size of each pane (Slide, Notes, and Outline) can be customized by dragging the pane splitter bar.

Text Figure: F03-14

Additional Notes:

The spell-checker checks for errors in note text, header and footer text, and slide text.
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